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1.  Penting

1.	Penting

Buku petunjuk elektronik ini ditujukan untuk 
siapapun yang menggunakan monitor Philips. 
Luangkan waktu untuk membaca panduan 
pengguna sebelum menggunakan monitor. Panduan 
tersebut berisi informasi dan catatan penting 
tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang 
penggunaannya ditangani dengan baik sesuai 
dengan petunjuk pengoperasian dan atas 
presentasi faktur asli atau resi yang menunjukkan 
tanggal pembelian, nama dealer, nomor model, dan 
nomor produksi produk.

1.1	Tindakan pencegahan dan pemeliharaan
	 Peringatan

Penggunaan kontrol, penyesuaian, maupun 
prosedur selain yang dijelaskan dalam dokumentasi 
ini dapat mengakibatkan sengatan listrik, bahaya 
listrik, dan/atau bahaya mekanis.
Baca dan ikuti petunjuk ini saat menyambungkan 
dan menggunakan monitor komputer.

Pengoperasian
•	 Jauhkan monitor dari sinar matahari langsung, 

kompor, maupun sumber panas lainnya.
•	 Pindahkan objek apapun yang dapat jatuh 

ke lubang ventilasi atau mungkin mencegah 
pendinginan elektronik yang benar pada 
monitor. 

•	 Jangan halangi lubang ventilasi pada kabinet.
•	 Saat menetapkan posisi monitor, pastikan 

konektor daya dan stopkontak mudah 
dijangkau.

•	 Jika mematikan monitor dengan melepaskan 
kabel daya atau kabel daya DC, tunggu selama 
6 detik sebelum memasang kabel daya atau 
kabel daya DC untuk pengoperasian biasa.

•	 Selalu gunakan kabel daya yang disetujui dan 
disediakan oleh Philips. Jika kabel daya tidak 
ada, hubungi pusat layanan setempat. (Lihat 
Pusat Informasi Layanan Pelanggan)

•	 Jaga agar monitor terhindar dari getaran 
kencang atau kondisi berbahaya lainnya selama 
pengoperasian berlangsung.

•	 Jaga agar monitor tidak terjatuh atau terbentur 
selama pengoperasian atau pengiriman.

Pemeliharaan
•	 Untuk melindungi monitor dari kemungkinan 

kerusakan, jangan letakkan benda berat di 
atas panel LCD. Saat memindahkan monitor, 
pegang bingkai untuk mengangkat, jangan 
angkat monitor dengan meletakkan tangan 
atau jari pada panel LCD.

•	 Lepas sambungan monitor jika Anda tidak akan 
menggunakannya dalam waktu lama.

•	 Lepas sambungan monitor jika Anda akan 
membersihkannya dengan kain yang lembab. 
Layar dapat dibersihkan dengan kain yang 
kering saat dimatikan. Namun, jangan pernah 
gunakan larutan organik, seperti alkohol 
atau cairan beramonia untuk membersihkan 
monitor.

•	 Untuk menghindari risiko sengatan listrik 
atau kerusakan permanen, jangan biarkan 
monitor terkena debu, hujan, atau air, maupun 
berada dalam lingkungan dengan kelembaban 
berlebihan.

•	 Jika monitor basah, segera seka dengan kain 
kering.

•	 Jika benda asing atau air masuk ke dalam 
monitor, segera matikan daya dan lepas kabel 
daya. Setelah itu, keluarkan benda asing atau 
air tersebut, lalu bawa ke pusat pemeliharaan.

•	 Jangan simpan atau gunakan monitor di lokasi 
yang bersuhu panas, terkena sinar matahari 
langsung, atau bersuhu sangat dingin.

•	 Untuk memelihara performa terbaik monitor 
dan memperpanjang masa pakainya, gunakan 
monitor di lokasi dalam kisaran suhu dan 
kelembaban berikut. 

oo Suhu: 0-40°C 32-95°F
oo Kelembaban: 20-80% RH
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1.  Penting

•	 PENTING: Aktifkan selalu program screensaver 
bergerak bila Anda meninggalkan monitor. 
Aktifkan selalu aplikasi refresh layar berkala jika 
monitor akan menampilkan konten statis yang 
tidak berubah. Tampilan gambar diam atau 
gambar statis yang tidak berubah dalam waktu 
lama dapat menimbulkan “efek terbakar”, 
disebut juga “jejak gambar” atau “bayangan”, di 
layar.
"Efek terbakar", "jejak gambar", atau "bayangan" 
adalah fenomena umum dalam teknologi 
panel LCD. Dalam sebagian besar kasus, “efek 
terbakar”, “jejak gambar”, atau “bayangan” akan 
menghilang secara bertahap dalam waktu 
tertentu setelah daya dimatikan. 

	 Peringatan
Gejala “efek terbakar”, “jejak gambar”, atau 
“bayangan” yang fatal tidak akan hilang dan tidak 
dapat diperbaiki. Kerusakan yang disebutkan di atas 
tidak tercakup dalam jaminan.

Layanan
•	 Penutup casing hanya dapat dibuka oleh teknisi 

ahli.
•	 Jika harus memperbaiki atau mengintegrasi 

dokumen, hubungi pusat layanan setempat. 
(lihat bab "Pusat Informasi Konsumen") 

•	 Untuk informasi pengiriman, lihat "Spesifikasi 
Teknis". 

•	 Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

	 Catatan
Hubungi teknisi servis jika monitor tidak beroperasi 
secara normal atau Anda tidak yakin dengan 
prosedur yang harus dilakukan bila petunjuk 
pengoperasian yang diberikan telah diikuti.

1.2	Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan 
yang digunakan dalam dokumen ini.
Catatan, Perhatian, dan Peringatan
Dalam buku petunjuk ini, beberapa teks mungkin 
disertai ikon dan dicetak dengan huruf tebal atau 
miring. Teks tersebut berisi catatan, perhatian, atau 
peringatan yang digunakan sebagai berikut:

	 Catatan
Ikon ini menunjukkan informasi penting dan tips 
yang akan membantu Anda memanfaatkan sistem 
komputer dengan lebih baik.

	 Perhatian
Ikon ini menunjukkan informasi yang 
memberitahukan Anda tentang cara menghindari 
kemungkinan kerusakan perangkat keras atau 
hilangnya data.

	 Peringatan
Ikon ini menunjukkan kemungkinan cedera 
dan memberitahukan Anda tentang cara 
menghindarinya.
Beberapa peringatan mungkin ditulis dalam format 
lain dan mungkin tidak disertai dengan ikon. Dalam 
hal ini, penulisan peringatan tertentu diwajibkan 
oleh peraturan pemerintah terkait.
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1.  Penting

1.3	Pembuangan produk dan materi kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging 
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic 
appliances, this product may not be disposed 
of with normal household waste. You are 
responsible for disposal of this equipment through 
a designated waste electrical and electronic 
equipment collection. To determine the locations 
for dropping off such waste electrical and 
electronic, contact your local government office, 
the waste disposal organization that serves your 
household or the store at which you purchased 
the product.
Your new monitor contains materials that can be 
recycled and reused. Specialized companies can 
recycle your product to increase the amount of 
reusable materials and to minimize the amount to 
be disposed of. 
All redundant packing material has been omitted. 
We have done our utmost to make the packaging 
easily separable into mono materials.

Please find out about the local regulations on how 
to dispose of your old monitor and packing from 
your sales representative. 

Recycling Information for Customers
Your display is manufactured with high quality 
materials and components which can be recycled 
and reused.
To learn more about our recycling program please 
visit www.philips.com/about/sustainability/recycling.
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2. Memasang monitor

2.1	Pemasangan

273E3L/273E3LH
	 Isi kemasan

2.	Memasang monitor

Register your product and get support at

www.philips.com/welcome
273E3L

Quick

Start

VGA (optional) DVI (optional)
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Monitor drivers

Quick Start Guide
SmartControl software

Audio cable (optional)   DVI  (opsional) VGA  (opsional) Kabel  audio 
 (opsional)

	 Memasang dudukan dasar

273E3L/273E3LH

1.	 Letakkan monitor menghadap ke bawah pada 
permukaan yang halus dan lembut agar layar 
tidak tergores atau rusak.

2.	 Pegang dudukan dasar monitor dengan kedua 
tangan dan masukkan dudukan dasar dengan 
kuat ke dalam batang dudukan.
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2. Memasang monitor

	 Menyambungkan ke PC

5

5

6 6

	 Input daya AC
	 Input VGA
	� Input DVI-D (Tersedia untuk model 

tertentu)
	 Kunci antipencurian Kensington
	 Input HDMI (Tersedia untuk model 

tertentu) 
	 Input audio masuk (Tersedia untuk model 

tertentu)

Menyambung ke PC

1.	 Sambungkan kabel daya dengan kuat ke 
bagian belakang monitor.

2.	 Matikan komputer dan lepas kabel daya.
3.	 Sambungkan kabel sinyal monitor ke 

konektor video di bagian belakang 
komputer.

4.	 Sambungkan kabel daya komputer dan 
monitor ke stopkontak di sekitar.

5.	 Hidupkan komputer dan monitor. Jika 
monitor menampilkan gambar, berarti 
pemasangan telah selesai.

2.2	Mengoperasikan monitor

273E3L

273E3LH

8

	 Keterangan produk bagian depan

: Untuk mengakses menu OSD.
: Kembali ke tingkat OSD sebelumnya.
: Beralih ke tampilan 4:3.
: Untuk menghidupkan dan mematikan 
daya monitor.

: Untuk menyesuaikan menu OSD.
: Untuk mengubah sumber input sinyal.

: SmartImage Lite. Ada tiga mode 
yang dapat dipilih: Standard 
(Standar), Internet, dan Game 
(Permainan).

! : Untuk mengatur volume suara layar.
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2. Memasang monitor

	 Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-Screen 
Display)?

OSD (On-Screen Display) adalah fitur yang 
terdapat pada semua monitor LCD Philips. 
Pengguna akhir dapat menggunakannya untuk 
menyesuaikan performa layar atau memilih fungsi 
monitor secara langsung melalui jendela petunjuk 
di layar. Antarmuka tampilan di layar yang mudah 
digunakan muncul seperti di bawah ini:












 

Petunjuk dasar dan mudah pada tombol kontrol

Dalam OSD yang ditunjukkan di atas, pengguna 
dapat menekan tombol   di bezel depan 
monitor untuk memindahkan kursor, OK untuk 
mengkonfirmasi pilihan atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari struktur 
On-Screen Display. Anda dapat menggunakannya 
sebagai referensi bila ingin melakukan penyesuaian 
lainnya nanti.

Main menu Sub menu

Input
VGA

DVI (available for selective models)

Picture
Wide screen,4:3

0~100

0~100

On, O�

Picture Format

Brightness

Contrast

SmartContrast

OSD Settings

0~100

0~100

O�, 1, 2, 3, 4

5, 10, 20, 30, 60

Horizontal

Vertical

Transparency

OSD Time out

Setup

0~100

On, O�

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution Noti�cation

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский  简体中文,Türkçe 

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temp.

sRGB

User De�ne

273E3L

Main menu Sub menu

Input
VGA

DVI

HDMI

Picture
Wide Screen,4:3

0~100

0~100

On, O�

On, O�

Picture Format

Brightness

Contrast

SmartResponse

On, O�

SmartContrast

OSD Settings

0~100

0~100

O�, 1, 2, 3, 4

5, 10, 20, 30, 60

Horizontal

Vertical

Transparency

OSD Time out

Setup

0~100

On, O�

Yes, No

0~100

0~100

On, O� 

0~100

H. Position

Over Scan

Auto

V. Position

Phase

Clock

Resolution Noti�cation

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский  简体中文,Türkçe 

Audio
Mute

Color
6500K, 9300K

Red: 0~100

Green: 0~100

Blue: 0~100

Color Temp.

sRGB

User De�ne

273E3LH

On, O�Stand-Alone
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2. Memasang monitor

	 Pemberitahuan resolusi

Monitor dirancang untuk memberikan performa 
optimal pada resolusi aslinya, 1920×1080@60Hz. 
Bila monitor dihidupkan pada resolusi yang 
berbeda, layar akan menampilkan peringatan: 
Gunakan 1920×1080@60Hz untuk hasil terbaik.
Tampilan peringatan resolusi asli dapat 
dinonaktifkan dari Setup (Konfigurasi) dalam menu 
OSD (On Screen Display).

	 Fungsi Fisik

Kemiringan

2.3	Melepas Dudukan dan Dudukan Dasar

	 Melepas Dudukan Dasar
Sebelum mulai membongkar penyangga monitor, 
ikuti petunjuk di bawah ini agar terhindar dari 
kerusakan atau cedera.

1.	Letakkan monitor menghadap ke bawah pada 
permukaan yang halus agar layar tidak tergores 
atau rusak.

2.	Tekan klip pengunci untuk melepas dudukan 
dasar dari batang dudukan.
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2. Memasang monitor

	 Melepas dudukan

Kondisi:

•	 Untuk aplikasi pemasangan standar VESA

1.	Lepas 3 penutup sekrup.

2.	Lepas 3 sekrup, lalu lepas dudukan dari monitor.

	 Catatan
Monitor mendukung antarmuka pemasangan yang 
kompatibel dengan VESA 100mm x 100mm.

100mm

100mm
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3.  Pengoptimalan     Gambar

	� Bagaimana cara mengaktifkan SmartImage 
Lite?

1.	 Tekan  untuk mengaktifkan SmartImage 
Lite di layar ;

2.	 Tekan terus  untuk beralih di antara 
Standard (Standar), Internet, dan Game 
(Permainan).

3.	 Tampilan SmartImage Lite akan tetap muncul 
di layar selama 5 detik atau Anda juga dapat 
menekan “OK” untuk mengkonfirmasi.

4.	 Bila SmartImage Lite diaktifkan, skema 
sRGB akan dinonaktifkan secara otomatis. 
Untuk menggunakan sRGB, Anda harus 
menonaktifkan SmartImage Lite dengan 
tombol  di bezel depan monitor.

Selain menggunakan tombol  untuk menggulir 
ke bawah, Anda juga dapat menekan tombol 

  untuk memilih, lalu menekan “OK” untuk 
mengkonfirmasi pilihan dan menutup OSD 
SmartImage Lite.
5.	 Ada tiga mode yang dapat dipilih: Standard 

(Standar), Internet, dan Game (Permainan).

3.	Pengoptimalan Gambar

3.1	SmartImage Lite

	� Apakah yang dimaksud dengan 
SmartContrast?

SmartImage Lite memberikan preset yang 
mengoptimalkan layar untuk berbagai jenis konten 
dengan menyesuaikan kecerahan, kontras, warna, 
serta ketajaman secara real time dan dinamis. 
Meskipun Anda bekerja dengan aplikasi teks, 
menampilkan gambar, atau menonton video, Philips 
SmartImage Lite memberikan performa monitor 
yang dioptimalkan.

	 Mengapa  saya  memerlukannya?

Anda memerlukan monitor yang memberikan 
tampilan semua jenis konten favorit yang 
dioptimalkan. Perangkat lunak SmartImage Lite 
akan menyesuaikan kecerahan, kontras, warna, 
serta ketajaman secara real time dan dinamis 
untuk menyempurnakan pengalaman tampilan 
monitor Anda.

	 Bagaimana  prosedurnya?

SmartImage Lite merupakan teknologi eksklusif 
dan canggih dari Philips yang menganalisis konten 
yang ditampilkan di layar. Berdasarkan skenario 
yang dipilih, SmartImage Lite menyempurnakan 
kontras, saturasi warna, dan ketajaman gambar 
secara dinamis untuk menyempurnakan konten 
yang sedang ditampilkan. Semua dapat dilakukan 
secara real time dengan menekan satu tombol.
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3.  Pengoptimalan     Gambar

3.2	SmartContrast

	� Apakah yang dimaksud dengan 
SmartContrast?

Teknologi unik yang secara dinamis menganalisis 
konten yang ditampilkan serta secara otomatis 
mengoptimalkan rasio kontras monitor LCD 
untuk kejernihan visual dan kenyamanan tampilan 
maksimal dengan menambah cahaya lampu latar 
agar gambar lebih jernih, tajam, dan terang, atau 
mengurangi cahaya lampu latar untuk tampilan 
gambar yang jelas di latar belakang gelap.

	 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan 
kenyamanan tampilan terbaik untuk setiap jenis 
konten. SmartContrast secara dinamis mengontrol 
kontras dan menyesuaikan cahaya lampu latar agar 
gambar dalam permainan serta video lebih jernih, 
tajam, dan terang, atau menampilkan teks yang jelas 
dan mudah dibaca untuk pekerjaan kantor. Dengan 
mengurangi pemakaian daya monitor, Anda 
menghemat biaya untuk daya dan memperpanjang 
masa pakai monitor.

	 Bagaimana prosedurnya?

Saat diaktifkan, SmartContrast akan menganalisis 
konten yang ditampilkan secara real time untuk 
menyesuaikan warna dan mengontrol intensitas 
cahaya lampu latar. Fungsi ini akan secara dinamis 
menyempurnakan kontras untuk pengalaman 
hiburan yang luar biasa saat menonton video atau 
menjalankan permainan.

•	 Standard (Standar): Menyempurnakan teks dan 
mengurangi kecerahan untuk meningkatkan 
kemampuan baca serta mengurangi kelelahan 
pada mata. Mode ini secara nyata akan 
menyempurnakan kemampuan baca dan 
produktivitas saat Anda bekerja dengan 
spreadsheet, file PDF, artikel yang dipindai, atau 
aplikasi kantor umum lainnya.

•	 Internet: Profil ini menggabungkan saturasi 
warna, kontras dinamis, dan penyempurnaan 
ketajaman untuk menampilkan foto dan 
gambar lain dengan kejernihan yang luar biasa 
dalam warna yang menarik. Semua dilakukan 
tanpa memerlukan alat bantu lain dan tanpa 
adanya warna yang pudar.

•	 Game (Permainan): Mengaktifkan sirkuit drive 
untuk waktu respons terbaik, menghilangkan 
tepi bergerigi untuk objek yang bergerak 
cepat di layar, serta meningkatkan rasio 
kontras untuk skema terang dan gelap. Profil 
ini memberikan pengalaman terbaik bagi 
penggemar permainan dalam menjalankan 
permainan.
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3.3	Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari 
Phillips memungkinkan Anda mengontrol monitor 
melalui antarmuka grafis layar yang mudah 
digunakan. Penyesuaian rumit sebelumnya kini 
tidak ada lagi karena panduan perangkat lunak 
yang mudah digunakan ini akan memandu Anda 
menyesuaikan resolusi penyempurnaan, Kalibrasi 
warna, Pengaturan jam/fase, Pengaturan titik putih 
RGB, dsb.

Dengan dilengkapi teknologi algoritme inti 
terbaru untuk pemrosesan serta respons yang 
cepat, perangkat lunak berbasis Ikon animasi yang 
menarik dan mendukung Windows 7 ini siap 
menyempurnakan pengalaman Anda menggunakan 
monitor Philips!

	 Penginstalan

•	 Ikuti petunjuk dan selesaikan penginstalan.
•	 Anda dapat mengaktifkannya setelah 

penginstalan selesai.
•	 Jika ingin mengaktifkannya di lain waktu, Anda 

dapat mengklik cara pintas di desktop atau 
toolbar.

Wizard pengaktifan pertama kali
•	 Setelah penginstalan SmartControl Lite selesai, 

Wizard pengaktifan pertama kali akan terbuka 
secara otomatis.

•	 Wizard ini akan memandu Anda menyesuaikan 
performa monitor secara bertahap.

•	 Menu Plug-in juga dapat dibuka untuk 
menjalankan wizard di lain waktu.

•	 Anda dapat menyesuaikan pilihan lainnya 
tanpa menggunakan wizard melalui panel 
Standard (Standar) .
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	 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):
•	 Menu Adjust (Penyesuaian) digunakan untuk 

menyesuaikan Brightness (Kecerahan), 
Contrast (Kontras), Focus (Fokus), Position 
(Posisi), dan Resolution (Resolusi).

•	 Anda dapat mengikuti petunjuk dan 
melakukan penyesuaian.

•	 Cancel (Batal) mengkonfirmasi pengguna jika 
ingin membatalkan penginstalan.
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Menu Color (Warna):
•	 Menu Color (Warna) digunakan untuk 

menyesuaikan RGB, Black Level (Tingkat 
Hitam), White Point (Titik Putih), Color 
Calibration (Kalibrasi Warna), dan SmartImage 
Lite (Lihat bagian SmartImage Lite).

•	 Anda dapat mengikuti petunjuk dan 
melakukan penyesuaian.

•	 Untuk item submenu berdasarkan input Anda, 
lihat tabel di bawah ini.

•	 Misalnya Color Calibration (Kalibrasi Warna).

1.	 "Show Me" (Tunjukkan) memulai tutorial 
kalibrasi warna.

2.	 Start (Mulai) - memulai urutan kalibrasi 
warna 6 langkah.

3.	 Quick View (Tampilan Ringkas) memuat 
gambar sebelum/sesudah kalibrasi.

4.	 Untuk kembali ke panel awal Color (Warna), 
klik tombol Cancel (Batal).

5.	 Enable color calibration (Aktifkan kalibrasi 
warna) - telah diaktifkan secara default. Jika 
tidak dicentang, kalibrasi warna tidak dapat 
dijalankan serta tombol mulai dan tampilan 
ringkas akan dinonaktifkan.

6.	 Info paten harus ditampilkan di layar kalibrasi.
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dilengkapi DDC/CI, hanya tab Help (Bantuan) dan 
Options (Pilihan) yang tersedia.

•	 Menampilkan pengaturan preferensi saat ini.
•	 Jika kotak dicentang, fitur akan diaktifkan. Kotak 

centang berfungsi sebagai pengunci.
•	 Enable Context Menu (Aktifkan Menu 

Konteks) di desktop dicentang (Aktif) secara 
default. Enable Context Menu (Aktifkan Menu 
Konteks) menampilkan pilihan Select Preset 
(Pilih Preset) dan Tune Display (Sempurnakan 
Layar) untuk SmartControl Lite dalam menu 
konteks klik kanan di desktop. Disabled 
(Dinonaktifkan) menghapus SmartControl Lite 
dari menu konteks klik kanan tersebut.

•	 Ikon Enable Task Tray (Aktifkan Baki Tugas) 
dicentang (Aktif) secara default. Aktifkan 
menu konteks menampilkan menu baki tugas 
untuk SmartControl Lite. Mengklik kanan 
ikon baki tugas akan menampilkan pilihan 
menu Help (Bantuan), Technical Support 
(Dukungan Teknis), Check for Update (Periksa 
Pembaruan), About (Tentang), dan Exit 
(Keluar). Bila Enable task tray menu (Aktifkan 
menu baki tugas) dinonaktifkan, ikon baki tugas 
hanya akan menampilkan EXIT (KELUAR).

•	 Run at Startup (Jalankan Saat Pengaktifan) 
dicentang (Aktif) secara default. Bila 
dinonaktifkan, SmartControl Lite tidak akan 
berjalan saat pengaktifan atau tidak akan 
ditampilkan dalam baki tugas. Satu-satunya 
cara menjalankan SmartControl Lite adalah 

Layar Kalibrasi warna pertama:

•	 Tombol Previous (Sebelumnya) dinonaktifkan 
hingga layar kalibrasi warna kedua ditampilkan.

•	 Next (Berikutnya) menampilkan layar sesuai 
urutan selanjutnya (6 target).

•	 Layar terakhir menampilkan panel File>Presets 
(File>Preset).

•	 Cancel (Batal) menutup antarmuka pengguna 
dan kembali ke halaman plug in.

SmartImage Lite
Memungkinkan pengguna mengubah pengaturan 
layar menjadi lebih baik berdasarkan konten.

Bila Entertainment (Hiburan) ditetapkan, 
SmartContrast dan SmartResponse akan 
diaktifkan.

Options>Preferences (Pilihan>Preferensi) - 
Hanya diaktifkan sewaktu memilih Preferences 
(Preferensi) dari menu drop-down Options 
(Pilihan). Di layar yang tidak didukung, namun 
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melalui cara pintas desktop atau file program. 
Preset apapun yang ditetapkan untuk berjalan 
saat pengaktifan tidak akan dimuat bila kotak 
ini tidak dicentang (Dinonaktifkan).

•	 Enable transparency mode (Aktifkan mode 
transparansi) (Windows 7, Vista, XP). Nilai 
default adalah 0% Tidak Tembus Cahaya.

Options>Input (Pilihan>Input) - Hanya diaktifkan 
sewaktu memilih Input dari menu drop-down 
Options (Pilihan). Di layar yang tidak didukung, 
namun dilengkapi DDC/CI, hanya tab Help 
(Bantuan) dan Options (Pilihan) yang tersedia. 
Semua tab SmartControl Lite lainnya tidak 
tersedia.

•	 Menampilkan panel petunjuk Source (Sumber) 
dan pengaturan sumber input saat ini.

•	 Di layar input tunggal, panel ini tidak akan 
ditampilkan.

Options>Audio (Pilihan>Audio) - Hanya 
diaktifkan sewaktu memilih Audio dari menu drop-
down Options (Pilihan).
Di layar yang tidak didukung, namun dilengkapi 
DDC/CI, hanya tab Help (Bantuan) dan Options 
(Pilihan) yang tersedia.
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Help>User Manual (Bantuan>Panduan Pengguna) 
- Hanya diaktifkan sewaktu memilih User Manual 
(Panduan Pengguna) dari menu drop-down Help 
(Bantuan). Di layar yang tidak didukung, namun 
dilengkapi DDC/CI, hanya tab Help (Bantuan) dan 
Options (Pilihan) yang tersedia.

Help>Version (Bantuan>Versi) - Hanya diaktifkan 
sewaktu memilih Version (Versi) dari menu drop- 
down Help (Bantuan). Di layar yang tidak didukung, 
namun dilengkapi DDC/CI, hanya tab Help 
(Bantuan) dan Options (Pilihan) yang tersedia.

Menu Sesuai Konteks
Context Sensitive Menu (Menu Sesuai Konteks) 
diaktifkan secara default. Jika Enable Context Menu 
(Aktifkan Menu Konteks) telah dicentang dalam 
panel Options>Preferences (Pilihan>Preferensi), 
menu tersebut akan ditampilkan.

Menu Konteks memiliki empat entri:
•	 SmartControl Lite - Bila dipilih, About Screen 

(Tentang Layar) akan ditampilkan.
•	 Select Preset (Pilih Preset) - Memberikan 

urutan menu preset yang disimpan untuk 
digunakan di lain waktu. Tanda centang 
menunjukkan preset yang saat ini dipilih. 
Preset Pabrik juga dapat dipilih dari menu 
drop down.

•	 Tune Display (Sempurnakan Layar) - 
Membuka panel kontrol SmartControl Lite.

•	 SmartImage Lite - Memeriksa pengaturan saat 
ini, seperti Standard (Standar), Internet, dan 
Game (Permainan).
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Menu Baki Tugas Diaktifkan
Menu baki tugas dapat ditampilkan dengan 
mengklik kanan ikon SmartControl Lite dari baki 
tugas. Klik kiri akan mengaktifkan aplikasi.

Baki tugas memiliki lima entri:
•	 Help (Bantuan) - Mengakses file User Manual 

(Panduan Pengguna): Buka file User Manual 
(Panduan Pengguna) menggunakan jendela 
browser default.

•	 Technical Support (Dukungan Teknis) - 
Menampilkan halaman dukungan teknis.

•	 Check for Update (Periksa Pembaruan) - 
Mengarahkan pengguna ke Arahan PDI dan 
memeriksa versi pengguna terhadap versi 
terbaru yang tersedia.

•	 About (Tentang) - Menampilkan informasi 
rinci tentang referensi: versi produk, informasi 
edisi, dan nama produk.

•	 Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite, 
pilih SmartControl Lite dari menu Program, lalu 
klik dua kali ikon PC desktop, atau hidupkan ulang 
sistem.

Menu Baki Tugas Dinonaktifkan
Bila Baki Tugas dinonaktifkan dalam folder 
preferensi, maka hanya pilihan EXIT (KELUAR) 
yang tersedia. Untuk menghapus SmartControl 
Lite secara keseluruhan dari baki tugas, nonaktifkan 
Run at Startup (Jalankan Saat Pengaktifan) dalam 
Options>Preferences (Pilihan>Preferensi).



18

4.  Spesifikasi Teknis

4.	Spesifikasi Teknis

273E3L/273E3LH

Gambar/Layar
Jenis panel LCD LCD TFT
Lampu latar WLED 273E3L/273E3LH
Ukuran panel 27" (68,6 cm)
Rasio aspek 16:9
Jarak Piksel 0,31 x 0,31 mm
Kecerahan 300 cd/m² 
SmartContrast 20,000,000:1
Rasio kontras (biasa) 1200:1
Waktu respons (biasa) 5 ms (273E3L), 1 ms (273E3LH)
Resolusi Optimum 1920x1080 @ 60Hz
Sudut pandang 170° (H)/160° (V) @C/R>10
Penyempurnaan Gambar SmartImage Lite
Warna layar 16,7 M
Kecepatan refresh vertikal 56Hz-76Hz
Frekuensi Horizontal 30kHz - 83kHz
sRGB YA
Konektivitas
Input sinyal DVI-D (digital), VGA (Analog)
Sinyal Input Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau
Kenyamanan
Kenyamanan Pengguna

Bahasa OSD Inggris, Prancis, Jerman, Italia, Rusia, Spanyol, China Modern, 
Portugis, Turki

Kenyamanan lainnya Kunci Kensington
Kompatibilitas Plug & Play DDC/CI, sRGB, Windows 7, Mac OSX, Linux
Dudukan
Kemiringan -5/+20
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273E3L
Daya  
Mode Aktif 27W (biasa)
Pemakaian Daya
(Metode pengujian 
EnergyStar 5.0)

Tegangan Input AC 
pada 100VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 115VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 230VAC +/-
5VAC, 50Hz +/- 5Hz

Pengoperasian Normal 
(biasa)

19,6W 19,5W 19,6W

Tidur (Siaga) 0,5W 0,5W 0,5W
Tidak Aktif 0,5W 0,5W 0,5W
Penghilangan Panas* Tegangan Input AC 

pada 100VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 115VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 230VAC +/-
5VAC, 50Hz +/- 5Hz

Pengoperasian Normal 66,89BTU/jam 66,55BTU/jam 66,89BTU/jam 
Tidur (Siaga) 1,71BTU/jam 1,71BTU/jam 1,71BTU/jam
Tidak Aktif 1,71BTU/jam 1,71BTU/jam 1,71BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

273E3LH
Daya  
Mode Aktif <27,3 W (biasa)

<32,3 W (maks.)
Pemakaian Daya
(Metode pengujian 
EnergyStar 5.0)

Tegangan Input AC 
pada 100VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 115VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 230VAC +/-
5VAC, 50Hz +/- 5Hz

Pengoperasian Normal 
(biasa)

20,43W 20,35W 20,40W

Tidur (Siaga) 0,5W 0,5W 0,5W
Tidak Aktif 0,3W 0,3W 0,3W
Penghilangan Panas* Tegangan Input AC 

pada 100VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 115VAC +/-
5VAC, 50Hz +/- 5Hz

Tegangan Input AC 
pada 230VAC +/-
5VAC, 50Hz +/- 5Hz

Pengoperasian Normal 69,73 BTU/jam 69,45 BTU/jam 69,62 BTU/jam
Tidur (Siaga) 1,71 BTU/jam 1,71 BTU/jam 1,71 BTU/jam
Tidak Aktif 1,02 BTU/jam 1,02 BTU/jam 1,02 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)
Catu Daya Efek terbakar, 100-240VAC, 50-60Hz
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Dimensi
Produk dengan dudukan 
(PxLxT) 

642x440x227mm

Produk tanpa dudukan (PxLxT) 642x391x64mm
Dimensi kemasan (PxLxT) 700x138x525mm
Berat
Produk dengan dudukan 8,2kg
Produk tanpa dudukan 6,5kg
Produk dengan kemasan 8,82 kg
Kondisi Pengoperasian
Kisaran suhu (beroperasi) 0°C hingga 40°C
Kisaran suhu (tidak beroperasi) -20°C hingga 60°C
Kelembaban relatif 20% hingga 80%
Ketinggian beroperasi: + 12.000 kaki (3.658 m)

tidak beroperasi: + 40.000 kaki (12.192 m)

MTBF 30.000 jam

Lingkungan

ROHS YA

EPEAT Perak. (www.epeat.net)

Kemasan 100% dapat didaur ulang

Bahan Kimia Khusus Bebas PVC/BFR3 untuk Komponen yang Dapat Diakses Pengguna 
(Tidak Termasuk Kabel dan Adaptor)

Kesesuaian dan standar

Pengesahan Peraturan Tanda CE, FCC Kelas B, SEMKO, TÜV/ 
GS, TÜV Ergo, UL/cUL, Energy star 5.0, TCO 5.1

Kabinet

Warna Hitam/Hitam

Lapisan Luar Tekstur/Tekstur

	 Catatan
1.	 EPEAT Emas atau Perak hanya berlaku di lokasi tempat produk Philips terdaftar. Untuk status 

registrasi di negara Anda, kunjungi www. epeat.net.
2.	 Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran versi 

terbaru, kunjungi www.philips.com/support.
3.	 Komponen yang dapat diakses pengguna pada monitor ini bebas PVC/BFR (penghambat nyala 

bromin dan polivinil klorida) (tidak termasuk kabel dan adaptor). Senyawa organobromin dalam 
bentuk penghambat nyala tidak boleh digunakan dalam kadar yang sama atau lebih besar dari 
0,09% (maksimal 900 ppm Bromin) dan senyawa organobromin dalam bentuk polivinil klorida atau 
kongenerik polivinil klorida tidak boleh digunakan dalam kadar yang sama atau lebih besar dari 0,1% 
(maksimal 1000 ppm Klorin).
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4.1	Mode Resolusi & Preset

	 Resolusi Maksimum

Untuk 273E3L/273E3LH
1920 x 1080 pada 60 Hz (input analog)
1920 x 1080 pada 60 Hz (input digital)

	 Resolusi yang Disarankan

Untuk 273E3L/273E3LH
1920 x 1080 pada 60 Hz (input digital)

Frek. H. (kHz) Resolusi Frek. V. (Hz)
31.47 720x400 70.09
31.47 640x480 59.94
35.00 640x480 66.67
37.86 640x480 72.81
37.50 640x480 75.00
37.88 800x600 60.32
46.88 800x600 75.00
48.36 1024x768 60.00
60.02 1024x768 75.03
63.89 1280x1024 60.02
79.98 1280x1024 75.03
55.94 1440x900 59.89
70.64 1440x900 74.98
65.29 1680x1050 59.95
67.50 1920x1080 60.00
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5.	 Manajemen Daya

5.1	Hemat Daya Otomatis

Jika PC dilengkapi perangkat lunak yang terinstal 
atau kartu tampilan yang terpasang sesuai dengan 
DPM VESA, monitor secara otomatis dapat 
mengurangi pemakaian daya saat tidak digunakan. 
Jika terdapat input dari keyboard, mouse, atau 
perangkat input lainnya yang terdeteksi, monitor 
akan 'bangun' secara otomatis. Tabel berikut 
menunjukkan pemakaian daya dan pemberian 
sinyal dari fitur hemat daya otomatis ini:

273E3L

Ketentuan Manajemen Daya
Mode 
VESA

Video Sinkronisasi 
horizontal 

Sinkronisasi 
vertikal

Daya yang 
Digunakan

Warna 
LED 

Aktif AKTIF Ya Ya <27 W (biasa) Putih

Tidur
(Siaga)

TIDAK 
AKTIF

Tidak Tidak <0,5 W Putih 
(berkedip)

Matikan TIDAK 
AKTIF

- - <0,5 W TIDAK 
AKTIF

273E3LH

Ketentuan Manajemen Daya
Mode 
VESA

Video Sinkronisasi 
horizontal 

Sinkronisasi 
vertikal

Daya yang 
Digunakan

Warna 
LED 

Aktif AKTIF Ya Ya <27,3 W (biasa)
<32,3 W (maks.)

Putih

Tidur
(Siaga) 

TIDAK 
AKTIF

Tidak Tidak <0,5 W Putih 
(berkedip)

Matikan TIDAK 
AKTIF

- - <0,3 W TIDAK 
AKTIF

Berikut adalah konfigurasi yang digunakan untuk 
menghitung pemakaian daya pada monitor.

Resolusi asli: 1920 x 1080
Kontras: 50%
Kecerahan: 300 nit
Suhu warna: 6.500k dengan pola putih sepenuhnya

	 Catatan
Informasi ini dapat berubah tanpa pemberitahuan 
sebelumnya.
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Lead-free Product

Lead free display promotes 
environmentally sound recovery and 
disposal of waste from electrical and 
electronic equipment. Toxic substances 

like Lead has been eliminated and compliance 
with European community’s stringent RoHs 
directive mandating restrictions on hazardous 
substances in electrical and electronic equipment 
have been adhered to in order to make Philips 
monitors safe to use throughout its life cycle.

Congratulations!  
This display is designed for both you and the 
planet!

The display you have just purchased 
carries the TCO Certified label. This 
ensures that your display is designed, 
manufactured and tested according 
to some of the strictest quality and 
environmental requirements in 

the world. This makes for a high performance 
product, designed with the user in focus that also 
minimizes the impact on the climate and our 
natural environment.

TCO Certified is a third party verified program, 
where every product model is tested by an 
accredited impartial test laboratory. TCO 
Certified represents one of the toughest 
certifications for displays worldwide.

Some of the Usability features of the TCO 
Certified for displays:

•	 Visual ergonomics for good image quality 
is tested to ensure top performance and 
reduce sight and strain problems. Important 
parameters are luminance, contrast, 
resolution, black level, gamma curve, colour 
and luminance uniformity and colour 
rendering

•	 Products are tested according to rigorous 
safety standards at impartial laboratories 

•	 Electric and magnetic fields emissions as low 
as normal household background levels

•	 Low acoustic noise emissions (when 
applicable)

Some of the Environmental features of the TCO 
Certified for displays:

•	 The brand owner demonstrates corporate 
social responsibility and has a certified 
environmental management system (EMAS or 
ISO 14001) 

•	 Very low energy consumption both in on- 
and standby mode minimize climate impact 

•	 Restrictions on chlorinated and brominated 
flame retardants, plasticizers, plastics and heavy 
metals such as cadmium, mercury and lead 
(RoHS compliance) 

•	 Both product and product packaging is 
prepared for recycling 

•	 The brand owner offers take-back options 

The requirements can be downloaded from our 
web site. The requirements included in this label 
have been developed by TCO Development in 
co-operation with scientists, experts, users as well 
as manufacturers all over the world. Since the end 
of the 1980s TCO has been involved in influencing 
the development of IT equipment in a more user-
friendly direction. Our labeling system started with 
displays in 1992 and is now requested by users 
and IT-manufacturers all over the world. About 
50% of all displays worldwide are TCO certified. 
 
For more information, please visit  
www.tcodevelopment.com 

 TCOFF1058 TCO Document, Ver. 2.1

Technology for you and the planet
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•	 2005/32/EC (EuP Directive, EC No. 		
	 1275/2008 mplementing Directive for 	
	 Standby and Off mode power consumption) 	
	 and is produced by a manufacturing 		
	 organization on ISO9000 level. 
•	 The product also comply with the following 	
	 standards 
•	 ISO9241-307:2008 (Ergonomic requirement, 	
	 Analysis and compliance test methods for 	
	 electronic visual displays)  
•	 GS EK1-2000:2009 (GS mark requirement)  
•	 prEN50279:1998 (Low Frequency Electric 	
	 and Magnetic fields for Visual Display) 
•	 MPR-II (MPR:1990:8/1990:10 Low Frequency 	
	 Electric and Magnetic fields) 
•	 TCO Displays 5.0 (Requirement for
	 Environment Labeling of Ergonomics, 	
	 Energy,  Ecology and Emission, TCO: Swedish 	
	 Confederation of Professional Employees) 	
	 for TCO versions 

Energy Star Declaration  
(www.energystar.gov)

“The EPEAT (Electronic Product 
Environmental Assessment Tool) 
program evaluates computer 
desktops, laptops, and monitors 
based on 51 environmental criteria 

developed through an extensive stakeholder 
consensus process supported by US EPA.
EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and select 
desktop computers, notebooks and monitors 
based on their environmental attributes. EPEAT 
also provides a clear and consistent set of 
performance criteria for the design of products, 
and provides an opportunity for manufacturers to 
secure market recognition for efforts to reduce 
the environmental impact of its products.”
Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity
This product is in conformity with the following 
standards 
•	 EN60950-1:2006 (Safety requirement of 	
	 Information Technology Equipment) 
•	 EN55022:2006 (Radio Disturbance 		
	 requirement of Information Technology 	
	 Equipment) 
•	 EN55024:1998+A1:2001+A2:2003 		
	 (Immunity requirement of Information 	
	  Technology Equipment) 
•	 EN61000-3-2:2006 (Limits for Harmonic 	
	 Current Emission) 
•	 EN61000-3-3:1995+A1:2001+A2:2005 	
	 (Limitation of Voltage Fluctuation and Flicker)
	 following provisions of directives applicable
•	 2006/95/EC (Low Voltage Directive) 
•	 2004/108/EC (EMC Directive)
 

EPEAT
(www.epeat.net)

As an ENERGY STAR® Partner, 
we have determined that this 
product meets the ENERGY STAR® 
guidelines for energy efficiency.

	Note
We recommend you switch off the monitor 
when it is not in use for a long time.
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Federal Communications Commission (FCC) 
Notice (U.S. Only)

	 This equipment has been tested and found 	
	 to comply with the limits for a Class B digital 	
	 device, pursuant to Part 15 of the FCC 
	 Rules. These limits are designed to 		
	 provide reasonable protection against 	
	 harmful interference in a residential 		
	 installation. This equipment generates, uses 	
	 and can radiate radio frequency energy and, 	
	 if not installed and used in accordance with
	 the instructions, may cause harmful 		
	 interference to radio communications. 	
	 However, there is no guarantee that 		
	 interference will not occur in a particular 	
	 installation. If this equipment does cause 	
	 harmful interference to radio or television 	
	 reception, which can be determined by 	
	 turning the equipment off and on, the user 
	 is encouraged to try to correct the 		
	 interference by one or more of the following 	
	 measures:
•	 Reorient or relocate the receiving antenna. 
•	 Increase the separation between the 	
	 equipment and receiver. 
•	 Connect the equipment into an outlet on 	
	 a circuit different from that to which the 	
	 receiver is connected. 
•	 Consult the dealer or an experienced radio/	
	 TV technician for help.

	 Changes or modifications not expressly 	
	 approved by the party responsible for 	
	 compliance could void the user's authority 	
	 to operate the equipment.

Use only RF shielded cable that was supplied with 
the monitor when connecting this monitor to a 
computer device. 
To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to rain 
or excessive moisture. 
THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 



26

6.  Informasi Peraturan

Commission Federale de la Communication  
(FCC Declaration)

	 Cet équipement a été testé et déclaré 	
	 conforme auxlimites des appareils 		
	 numériques de class B,aux termes de 	
	 l'article 15 Des règles de la FCC. Ces limites 	
	 sont conçues de façon à fourir une  
	 protection raisonnable contre les 		
	 interférences nuisibles dans le cadre 		
	 d'une installation résidentielle. 
	 CET appareil produit, utilise et peut émettre 	
	 des hyperfréquences qui, si l'appareil 	
	 n'est pas installé et utilisé selon les consignes 	
	 données, peuvent causer des interférences 	
	 nuisibles aux communications radio. 
	 Cependant, rien ne peut garantir l'absence 	
	 d'interférences dans le cadre d'une 		
	 installation particulière. Si cet appareil est la 	
	 cause d'interférences nuisibles pour la 	
	 réception des signaux de radio ou de 	
	 télévision, ce qui peut être décelé en fermant 	
	 l'équipement, puis en le remettant en 	
	 fonction, l'utilisateur pourrait essayer de 	
	 corriger la situation en prenant les mesures 	
	 suivantes:
•	 Réorienter ou déplacer l'antenne de 	
	 réception. 
•	 Augmenter la distance entre l'équipement et 	
	 le récepteur. 
•	 Brancher l'équipement sur un autre circuit 	
	 que celui utilisé par le récepteur. 
•	 Demander l'aide du marchand ou d'un 	
	 technicien chevronné en radio/télévision.

	 Toutes modifications n'ayant pas reçu 	
	 l'approbation des services compétents en 	
	 matière de conformité est susceptible 	
	 d'interdire à l'utilisateur l'usage du présent 	
	 équipement.

N'utiliser que des câbles RF armés pour les 
connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 
EN 55022 Compliance (Czech Republic Only)
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Polish  Center  for  Testing  and  Certification  
Notice

The equipment should draw power from a socket 
with an attached protection circuit (a three-
prong socket). All equipment that works together 
(computer, monitor, printer, and so on) should 
have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.

North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR DU 
STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL:  
S Ø R G  V E D  P L AC E R I N G E N  F O R , AT 
NETLEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS:  
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VO IDAAN TARV ITTAESSA  HELPOST I 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE  PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)
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China RoHS

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

 

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den 
in der "Verordnung über den Schutz vor Schäden 
durch Röntgenstrahlen" festgelegten Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften über 
die Bauart von Störstrahlern nach Anlage III ¤ 5 
Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 
1.	 Reparaturen nur durch Fachpersonal 	
	 durchgeführt werden. 
2.	 nur original-Ersatzteile verwendet werden. 
3.	 bei Ersatz der Bildröhre nur eine 		
	 bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf dunklem 
Untergrund zu verwenden (schlechte Lesbarkeit 
und erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel nach 
DIN 45 635 beträgt 70dB (A) oder weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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7.	� Layanan pelanggan dan 
jaminan

7.1	Kebijakan Cacat Piksel Monitor Panel Datar 
Philips

Philips berupaya memberikan produk berkualitas 
tertinggi. Kami menggunakan beberapa proses 
produksi tercanggih di industri dan menerapkan 
kontrol kualitas yang ketat. Namun, cacat piksel 
atau subpiksel pada panel LCD TFT yang digunakan 
di monitor panel datar terkadang tidak dapat 
dihindari. Tidak ada produsen yang dapat menjamin 
semua panel akan bebas dari cacat piksel, namun 
Philips menjamin bahwa setiap monitor dengan 
jumlah cacat yang tidak dapat diterima akan 
diperbaiki atau diganti sesuai dengan jaminan 
yang berlaku. Pemberitahuan ini menjelaskan 
berbagai jenis cacat piksel dan menentukan 
tingkat cacat yang dapat diterima untuk masing-
masing jenis tersebut. Untuk memenuhi syarat 
dalam mendapatkan perbaikan atau penggantian 
sesuai jaminan, jumlah cacat piksel pada panel 
LCD TFT harus melampaui tingkat yang dapat 
diterima. Misalnya, jumlah cacat subpiksel pada 
monitor tidak boleh lebih dari 0,0004%. Philips 
bahkan selanjutnya menentukan standar kualitas 
lebih tinggi untuk jenis atau kombinasi cacat piksel 
tertentu yang lebih nyata dibandingkan dengan 
yang lainnya. Kebijakan ini berlaku secara global.

Piksel dan Subpiksel
Piksel, atau elemen gambar, terdiri dari tiga 
subpiksel dalam warna utama merah, hijau, dan 
biru. Kombinasi beberapa piksel akan membentuk 
gambar. Bila semua subpiksel pada piksel menyala, 
kombinasi ketiga subpiksel berwarna tersebut akan 
muncul sebagai satu piksel putih. Bila semua mati, 
kombinasi ketiga subpiksel berwarna akan muncul 
sebagai satu piksel hitam. Kombinasi lainnya dari 

subpiksel yang menyala dan mati akan muncul 
sebagai satu piksel warna lain.

Jenis Cacat Piksel
Cacat piksel dan subpiksel muncul di layar dalam 
berbagai bentuk. Ada dua kategori cacat piksel 
dan masing-masing kategori tersebut terdiri dari 
beberapa jenis cacat subpiksel.

Cacat Titik Terang
Cacat titik terang muncul sebagai piksel maupun 
subpiksel yang selalu terang atau 'menyala'. 
Karenanya, titik terang merupakan subpiksel yang 
terlihat jelas di layar bila monitor menampilkan 
pola gelap. Berikut adalah jenis cacat titik terang:

Satu subpiksel merah, hijau, atau biru terang

Dua subpiksel terang yang berdekatan:
-- Merah + Biru = Ungu
-- Merah + Hijau = Kuning
-- Hijau + Biru = Cyan (Biru Muda)

Tiga subpiksel terang yang berdekatan (satu piksel 
putih)

Subpiksel Subpiksel Subpiksel

piksel
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	 Catatan

Titik terang merah atau biru harus lebih dari 50 
persen lebih terang daripada titik di sekitarnya, 
sedangkan titik terang hijau 30 persen lebih terang 
daripada titik di sekitarnya.

Cacat Titik Gelap
Cacat titik gelap muncul sebagai piksel maupun 
subpiksel yang selalu gelap atau 'mati'. Karenanya, 
titik gelap merupakan subpiksel yang terlihat jelas 
di layar bila monitor menampilkan pola terang. 
Berikut adalah jenis cacat titik gelap:

Jarak Cacat Piksel  
Karena cacat piksel dan subpiksel sejenis yang 
saling berdekatan mungkin terlihat lebih nyata, 
Philips juga menentukan toleransi untuk jarak cacat 
piksel.

Toleransi Cacat Piksel
Untuk memenuhi syarat dalam mendapatkan 
perbaikan atau penggantian karena cacat piksel 
selama masa berlaku jaminan, panel LCD TFT pada 
monitor panel datar Philips harus memiliki cacat 
piksel maupun subpiksel melebihi toleransi yang 
tercantum dalam tabel berikut ini.

CACAT TITIK TERANG TINGKAT YANG DAPAT DITERIMA
1 subpiksel terang 3
2 subpiksel terang yang berdekatan 1
3 subpiksel terang yang berdekatan (satu piksel putih) 0
Jarak di antara dua cacat titik terang* >15mm
Total cacat titik terang dari semua jenis 3

CACAT TITIK GELAP TINGKAT YANG DAPAT DITERIMA
1 subpiksel gelap 5 atau lebih sedikit
2 subpiksel gelap yang berdekatan 2 atau lebih sedikit
3 subpiksel gelap yang berdekatan 0
Jarak di antara dua cacat titik gelap* >15mm
Total cacat titik gelap dari semua jenis 5 atau lebih sedikit

TOTAL CACAT TITIK TINGKAT YANG DAPAT DITERIMA
Total cacat titik terang atau titik gelap dari semua jenis 5 atau lebih sedikit

	 Catatan 
1.	 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
2.	 Monitor ini sesuai dengan ISO 9241-307. (ISO9241-307: Metode pengujian kesesuaian, analisis, dan 

persyaratan ergonomis untuk tampilan visual elektronik)
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7.2	Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di 
negara Anda, kunjungi situs Web www.philips.com/support. Anda juga dapat menghubungi nomor Pusat 
Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara ASC Nomor layanan konsumen Harga

Germany Siemens I&S +49 01803 386 853 € 0.09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0.10

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Italy A-novo +39 840 320 041 € 0.08

Netherlands E Care +31 0900 0400 063 € 0.10

Denmark A-novo +45 3525 8761 Local call tariff

Norway A-novo +47 2270 8250 Local call tariff

Sweden A-novo +46 08 632 0016 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Austria Siemens I&S +43 0810 000206 € 0.07

Belgium E Care +32 078 250851 € 0.06

Luxembourg E Care +352 26 84 30 00 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

Negara Pusat informasi ASC Nomor layanan konsumen

BELARUS NA IBA +375 17 217 3386

BULGARIA NA LAN Service +359 2 960 2360

CROATIA NA Renoprom +385 1 333 0974

ESTONIA NA FUJITSU +372 6519900

LATVIA NA “ServiceNet LV” Ltd. +371 7460399

LITHUANIA NA UAB "Servicenet" +370 7400088

ROMANIA NA Blue Ridge Intl. +40 21 2101969

SERBIA & 
MONTENEGRO

NA Kim Tec d.o.o. +381 11 20 70 684

SLOVENIA NA PC H.and +386 1 530 08 24

UKRAINE
NA Comel +380 562320045 

NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155

Turkey NA Techpro +90 212 444 4 832

Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331 

NA Profi Service +36 1 814 8080

Informasi kontak untuk kawasan AMERIKA LATIN:

Negara Pusat informasi Nomor layanan konsumen

Brazil
Vermont

0800-7254101

Argentina 0800 3330 856

Informasi kontak untuk China:

China
Nomor layanan konsumen: 4008 800 008

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi ASC Nomor layanan konsumen

U.S.A. TOS Teleplan (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Informasi kontak untuk kawasan APMEA:

Negara Pusat informasi ASC Nomor layanan konsumen

Australia NA AGOS NETWORK PTY LTD 1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / 
Macau

NA Smart Pixels Technology Ltd.
Hong Kong:Tel: +852 2619 9639
Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396
SMS: PHILIPS to 56677

Indonesia NA
PT. Gadingsari elektronika 
Prima

Tel: 62 21 75909053, 75909056, 
7511530

South Korea NA PCS One Korea Ltd. 080-600-6600

Malaysia NA
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer 
Care Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices Taiwan

FETEC.CO 0800-231-099

Thailand NA
Axis Computer System Co., 
Ltd.

(662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888

UNITED ARAB 
EMIRATES

NA
AL SHAHD COMPUTER 
L.L.C

00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City
+84 5113.562666 Danang City
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc.
(02) 633-4533 to 34,
(02) 637-6559 to 60

Sri Lanka NA
no distributor and/or service 
provider currently

Bangladesh NA
Distributor: Computer Source 
Ltd (warranty buy-out)

880-2-9141747, 9127592
880-2-8128848 / 52

Nepal NA
Distributor: Syakar Co. Ltd 
(warranty buy-out)

977-1-4222395 

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) (warranty 
buy-out)

855-023-999992
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8.	� Mengatasi masalah & Tanya 
jawab

8.1	Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang 
dapat diatasi pengguna. Jika masalah terus berlanjut 
setelah Anda mencoba solusi berikut, hubungi staf 
layanan pelanggan Philips.

	 Masalah Umum

Tidak Ada Gambar (LED Daya mati)
•	 Pastikan kabel daya telah tersambung ke 

stopkontak dan ke bagian belakang monitor.
•	 Pastikan terlebih dulu tombol daya di bagian 

depan monitor telah berada dalam posisi 
OFF (TIDAK AKTIF), lalu tekan ke posisi ON 
(AKTIF).

Tidak Ada Gambar (LED Daya Putih)
•	 Pastikan komputer telah dihidupkan.
•	 Pastikan kabel sinyal telah tersambung dengan 

benar ke komputer.
•	 Pastikan pin pada kabel monitor yang 

tersambung tidak tertekuk. Jika ya, perbaiki 
atau ganti kabel.

•	 Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

•	 Pastikan kabel monitor telah tersambung 
dengan benar ke komputer. (Lihat juga 
Panduan Ringkas).

•	 Periksa pin yang tertekuk pada kabel monitor.
•	 Pastikan komputer telah dihidupkan.

Tombol AUTO (OTOMATIS) tidak berfungsi
•	 Fungsi otomatis hanya berlaku dalam mode 

Analog VGA. Jika hasilnya tidak memuaskan, 
Anda dapat melakukan penyesuaian manual 
melalui menu OSD.

	 Catatan
Fungsi Otomatis tidak berlaku dalam mode 
Digital DVI karena fungsi tersebut tidak 
diperlukan.

Tanda yang tampak seperti asap atau kilatan api
•	 Jangan lakukan langkah-langkah apapun untuk 

mengatasi masalah
•	 Lepaskan segera monitor dari catu daya 

utama untuk keselamatan
•	 Hubungi segera staf layanan pelanggan Philips.

	 Masalah Gambar

Gambar tidak berada di tengah
•	 Atur posisi gambar menggunakan fungsi “Auto” 

(Otomatis) dalam Kontrol Utama OSD.
•	 Atur posisi gambar menggunakan Phase/

Clock (Fase/Jam) dalam Setup (Konfigurasi) 
di Kontrol Utama OSD. Hal ini hanya berlaku 
dalam mode VGA.

Gambar bergetar di layar
•	 Pastikan kabel sinyal telah tersambung dengan 

benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar

•	 Atur gambar menggunakan fungsi “Auto” 
(Otomatis) dalam Kontrol Utama OSD.

•	 Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi) 
di Kontrol Utama OSD. Hal ini hanya berlaku 
dalam mode VGA.
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Kelip horizontal muncul di layar

•	 Atur gambar menggunakan fungsi “Auto” 
(Otomatis) dalam Kontrol Utama OSD.

•	 Hilangkan baris vertikal menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi) 
di Kontrol Utama OSD. Hal ini hanya berlaku 
dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu 
gelap
•	 Atur kontras dan kecerahan di OSD 

(On-Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan" 
tetap muncul setelah daya dimatikan.
•	 Tampilan gambar diam atau gambar statis 

yang tidak berubah dalam waktu lama dapat 
menimbulkan “efek terbakar”, disebut juga 
“jejak gambar” atau “bayangan”, di layar. “Efek 
terbakar”, “jejak gambar”, atau “bayangan” 
adalah fenomena umum dalam teknologi 
panel monitor. Dalam sebagian besar kasus, 
“efek terbakar”, “jejak gambar”, atau “bayangan” 
akan menghilang secara bertahap dalam waktu 
tertentu setelah daya dimatikan.

•	 Aktifkan selalu program screensaver bergerak 
bila Anda meninggalkan monitor.

•	 Aktifkan selalu aplikasi refresh layar berkala 
jika Monitor akan menampilkan konten statis 
yang tidak berubah.

•	 Gejala “efek terbakar”, “jejak gambar”, atau 
“bayangan” yang fatal tidak akan hilang 
dan tidak dapat diperbaiki. Kerusakan yang 
disebutkan di atas tidak tercakup dalam 
jaminan.

Gambar tampak berubah.  Teks tidak jelas atau 
buram.
•	 Atur resolusi layar PC ke mode sama seperti 

resolusi asli layar yang disarankan monitor.

Titik hijau, merah, biru, hitam, dan putih muncul 
di layar
•	 Titik tersisa adalah karakter normal yang 

muncul pada liquid crystal yang digunakan 
dalam teknologi saat ini. Untuk informasi lebih 
rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan 
mengganggu
•	 Anda dapat mengatur lampu “daya hidup” 

menggunakan Konfigurasi LED daya dalam 
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat 
Informasi Konsumen dan hubungi staf layanan 
pelanggan Philips.
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8.2	Tanya Jawab SmartControl Lite

P1.	� Saya mengganti monitor PC dan 
SmartControl Lite menjadi tidak dapat 
digunakan. Apa yang harus saya lakukan?

Jawab:	� Hidupkan ulang PC dan lihat apakah 
SmartControl Lite dapat berfungsi. Jika 
tidak, hapus dan instal ulang SmartControl 
Lite untuk memastikan driver yang benar 
telah diinstal.

P2.	� SmartControl Lite berfungsi dengan baik 
sebelumnya, namun kini tidak lagi. Apa 
yang dapat saya lakukan?

Jawab:	�Jika tindakan berikut dilakukan, driver 
monitor mungkin perlu diinstal ulang.

•	Mengganti adapter grafis video
•	Memperbarui driver video
•	 �Aktivitas pada OS, misalnya service pack 

atau patch
•	 �Jalankan Windows Update serta driver 

monitor dan/atau video yang diperbarui
•	 �Boot di Windows dijalankan dengan 

monitor dalam kondisi mati atau tidak 
tersambung.

•	 �Untuk mengetahuinya, klik kanan My 
Computer (Komputer Saya), lalu klik 
Properties->Hardware-> Device Manager 
(Properti->Perangkat Keras->Manajer 
Perangkat).
Jika "Plug and Play Monitor" (Monitor Plug 
and Play) ditampilkan dalam Monitor, Anda 
harus menginstal ulang. Hapus dan instal 
ulang SmartControl Lite.

P3.	� Setelah menginstal SmartControl Lite, bila 
tab SmartControl Lite diklik, layar tidak 
menampilkan apapun setelah beberapa 
saat atau layar menampilkan pesan 
kegagalan. Mengapa demikian?

Jawab:	�Adapter grafis mungkin tidak kompatibel 
dengan SmartControl Lite. Jika adapter 
grafis adalah salah satu merek yang 
disebutkan di atas, coba download driver 
adapter grafis terbaru dari situs Web 

perusahaan yang terkait. Instal driver. Hapus 
SmartControl Lite, lalu instal ulang sekali 
lagi.
Jika tetap tidak berfungsi, kami mohon 
maaf bahwa adapter grafis tersebut tidak 
didukung. Kunjungi situs Web Philips dan 
lihat apakah driver SmartControl Lite 
terbaru telah tersedia.

P4.	� Bila saya mengklik Product Information 
(Informasi Produk), hanya sebagian 
informasi yang ditampilkan. Mengapa 
demikian?

Jawab:	�Driver adapter kartu grafis mungkin bukan 
merupakan versi terbaru yang sepenuhnya 
mendukung antarmuka DDC/CI. Coba 
download driver adapter grafis terbaru dari 
situs Web perusahaan yang terkait. Instal 
driver. Hapus SmartControl Lite, lalu instal 
ulang sekali lagi.

P5.	� Saya lupa PIN untuk Fungsi Theft 
Deterrence (Pencegahan Pencurian). Apa 
yang dapat saya lakukan?

Jawab:	� Pusat Layanan Philips berhak meminta 
identifikasi dan otorisasi resmi untuk 
menetapkan kepemilikan monitor.
Perlu diketahui bahwa fungsi pencegahan 
antipencurian diberikan sebagai pilihan 
yang bebas dan mudah. Mengelola nomor 
PIN adalah sepenuhnya tanggung jawab 
pengguna, baik perorangan maupun 
organisasi, yang membuatnya.
Jika lupa nomor PIN, pusat layanan 
Philips dapat membuat ulang PIN untuk 
Anda dengan membebankan sejumlah 
biaya setelah verifikasi kepemilikan. Perlu 
diketahui bahwa aktivitas ini tidak tercakup 
dalam persyaratan jaminan standar.
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8.3	Tanya Jawab Umum

P1:	� Sewaktu memasang monitor, apa yang 
harus saya lakukan jika layar menampilkan 
"Cannot display this video mode" (Tidak 
dapat menampilkan mode video ini)?

Jawab:	�Resolusi yang disarankan untuk monitor ini: 
1920 x 1080 @60Hz.

•	 �Lepas semua kabel, lalu sambungkan PC ke 
monitor yang digunakan sebelumnya.

•	 �Dalam Windows Start Menu (Menu 
Mulai Windows), pilih Settings/Control 
Panel(Pengaturan/Panel Kontrol) . Dalam 
Control Panel Window (Jendela Panel 
Kontrol), pilih ikon Display (Tampilan). 
Dalam Display Control Panel (Panel 
Kontrol Tampilan), pilih tab "Settings" 
(Pengaturan). Dalam tab pengaturan, 
dalam kotak "desktop area" (area desktop), 
gerakkan panel samping ke piksel 1920 x 
1080

•	 �Buka "Advanced Properties" (Properti 
Lanjutan), atur Kecepatan Refresh ke 60Hz, 
lalu klik OK.

•	 �Hidupkan ulang komputer, lalu ulangi 
langkah 2 dan 3 untuk memverifikasi bahwa 
PC telah diatur ke 1920 x 1080 @60Hz.

•	 �Matikan komputer, lepas monitor lama, lalu 
sambungkan monitor Philips.

•	 �Hidupkan monitor, lalu hidupkan PC.

P2:	� Berapa kecepatan refresh yang disarankan 
untuk Monitor?

Jawab:	�Kecepatan refresh yang disarankan untuk 
Monitor adalah 60Hz. Jika terdapat 
gangguan di layar, Anda dapat mengaturnya 
hingga 75Hz untuk mengetahui apakah 
gangguan tersebut dapat diatasi.

P3:	� Apakah yang dimaksud dengan file .inf 
dan .icm pada CD-ROM?  Bagaimana cara 
menginstal driver (.inf dan .icm)?

Jawab:	�Ini adalah file driver untuk monitor. Untuk 
menginstal driver, ikuti petunjuk dalam 

panduan pengguna. Komputer mungkin 
akan menanyakan driver monitor (file 
.inf dan .icm) atau disk driver saat Anda 
menginstal monitor untuk pertama kalinya. 
Ikuti petunjuk tentang cara memasukkan 
CD-ROM pendamping yang disertakan 
dalam kemasan ini. Driver monitor (file .inf 
dan .icm) akan diinstal secara otomatis.

P4:	� Bagaimana cara mengatur resolusi?

Jawab:	� Kombinasi driver grafis/kartu video dan 
monitor akan menentukan resolusi yang 
tersedia. Anda dapat memilih resolusi yang 
diinginkan dalam Panel Kontrol Windows® 
dengan “Display properties” (Properti 
tampilan).

P5:	� Bagaimana jika saya salah melakukan 
penyesuaian monitor melalui OSD?

Jawab:	�Tekan tombol OK, lalu pilih "Reset" (Atur 
Ulang) untuk menggunakan kembali semua 
pengaturan pabrik awal.

P6:	� Apakah layar LCD antigores?

Jawab:	�Secara umum, sebaiknya permukaan 
panel tidak mengalami guncangan yang 
berlebihan dan terlindungi dari benda 
tajam atau tumpul. Sewaktu menangani 
monitor, pastikan tidak ada tekanan atau 
kekuatan berlebihan yang diberikan pada 
sisi permukaan panel. Tindakan ini dapat 
mempengaruhi ketentuan jaminan.

P7:	� Bagaimana seharusnya cara membersihkan 
permukaan LCD?

Jawab:	�Untuk pembersihan normal, gunakan kain 
bersih dan lembut. Untuk pembersihan 
secara menyeluruh, gunakan isopropil 
alkohol. Jangan gunakan bahan pelarut 
lainnya seperti etil alkohol, ethanol, aseton, 
hexane, dll.

P8:	� Apakah pengaturan warna pada monitor 
dapat diubah?
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8.  Mengatasi masalah & Tanya jawab

Jawab:	� Ya. Anda dapat mengubah pengaturan 
warna melalui kontrol OSD sesuai 
prosedur berikut,

•	 �Tekan "OK" untuk menampilkan menu 
OSD (On Screen Display)

•	 �Tekan "Down Arrow" (Panah Bawah) untuk 
menggunakan pilihan "Color" (Warna), lalu 
tekan "OK" untuk membuka pengaturan 
warna. Berikut adalah tiga pengaturan yang 
tersedia.
1.	Color Temperature (Suhu Warna); 

Enam pengaturan suhu warna adalah 
5000K, 6500K, 7500K, 8200K, 9300K, 
dan 11500K. Dengan pengaturan dalam 
kisaran 5000K, panel menampilkan 
"hangat" dengan nada warna merah-putih, 
sedangkan suhu 11500K menghasilkan 
"nada dingin, biru-putih".

2.	sRGB; Ini adalah pengaturan standar 
untuk memastikan pertukaran warna 
yang benar di antara berbagai perangkat 
(misalnya kamera digital, monitor, printer, 
pemindai, dll.) 

3.	User Define (Ditentukan Pengguna); 
Pengguna dapat memilih pengaturan 
warna sesuai keinginannya dengan 
menyesuaikan warna merah, hijau, dan 
biru.

	 Catatan:
Penghitungan warna lampu yang dipancarkan 
oleh benda tertentu sewaktu sedang 
dipanaskan. Penghitungan ini diberikan dalam 
persyaratan skala absolut, (derajat Kelvin). 
Suhu Kelvin lebih rendah seperti 2004K 
berwarna merah; suhu lebih tinggi seperti 
9300K berwarna biru. Suhu netral adalah putih 
pada 6504K.

P9:	� Apakah Monitor dapat disambungkan ke 
PC manapun, workstation, atau Mac?

Jawab:	� Ya. Semua Monitor Philips kompatibel 
sepenuhnya dengan PC, Mac, dan 
workstation standar. Anda mungkin 
memerlukan adapter kabel untuk 
menyambungkan monitor ke sistem Mac. 
Untuk informasi lebih lanjut, hubungi staf 
penjualan Philips.

P10:	� Apakah Monitor Philips memiliki fungsi 
Plug-and-Play?

Jawab:	� Ya. Monitor merupakan perangkat Plug-
and-Play yang kompatibel dengan Windows 
7/Vista/XP/NT, Mac OSX, Linux

P11:	� Apa yang dimaksud dengan Gambar 
Menempel, Efek Terbakar, Jejak Gambar, 
atau Bayangan pada panel LCD?

Jawab:	�Tampilan gambar diam atau gambar statis 
yang tidak berubah dalam waktu lama 
dapat menimbulkan "efek terbakar", disebut 
juga "jejak gambar" atau "bayangan", di 
layar. "Efek terbakar", "jejak gambar", atau 
"bayangan" adalah fenomena umum dalam 
teknologi panel LCD. Dalam sebagian 
besar kasus, "efek terbakar", "jejak gambar", 
atau "bayangan" akan menghilang secara 
bertahap dalam waktu tertentu setelah 
daya dimatikan.
Aktifkan selalu program screensaver 
bergerak bila Anda meninggalkan monitor.
Aktifkan selalu aplikasi refresh layar berkala 
jika Monitor akan menampilkan konten 
statis yang tidak berubah.

	 Peringatan
Gejala "efek terbakar", "jejak gambar", atau 
"bayangan" yang fatal tidak akan hilang dan 
tidak dapat diperbaiki. Kerusakan yang 
disebutkan di atas tidak tercakup dalam 
jaminan.

P12:	� Mengapa Layar tidak menampilkan teks 
yang jelas, namun menampilkan karakter 
bergerigi?

Jawab:	� Monitor berfungsi paling baik pada resolusi 
asli 1920 x 1080 @60Hz. Untuk tampilan 
terbaik, gunakan resolusi ini.
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